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Before Reading
The RCB-3 is a third-generation control board developed for use with Kondo KHR-series robots. 
This manual explains how to connect the RCB-3; and how to use the newly developed control 
software application, HeartToHeart3. Please read this manual carefully along with the other 
instruction manuals related to this product. 
Note: Some manual sections have explanations that use the Kondo KHR-2HV or other KHR-series 
robots as examples. Please take this into account if you are using this manual for products other 
than those used in the examples.
This manual applies to the following versions of the HeartToHeart3 software and RCB-3 firmware. 

HeartToHeart3 2007/02/05 version and later 
RCB-3 Ver1.03 2007/02/05 version and later

Manual Organization

RCB-3 Hardware Manual 

HeartToHeart3 Software Manual 

This manual covers connecting to the RCB-3 and other issues related to the hardware. It also 
gives explanations of peripheral related options. 
When using RCB-3 for the first time, please do not skip this section. 

Introduction 
This section explains the basic operation and functionality, like creating simple motions.
The HeartToHeart3 application was specifically developed for use with the RCB-3 controller. Using 
the applications GUI interface, you can easily create motion sequences for the robot.
 
This section will teach you the basic functionality.

Intermediate 
In addition to the operations explained in the Introduction, the Intermediate section provides 
explanations of operations like creating motion sequences that utilize gyro sensor compensation, 
and wireless radio remote control. 
With the functions covered in the Introduction and Intermediate sections, you should be able to do 
almost all the operations you were able to do with the  previous control boards.

Software
This section gives detailed explanations for each function of the software application. Read, or refer 
to, this section when you want to learn the name and operation of each part of the application. 

In addition to this manual, more-advanced operations are explained on the Kondo Robot website. 
Also, check the support page regularly for information concerning this manual or updates after 
purchase. 

http://www.kondo-robot.com/EN

Advanced
The Advanced section provides explanations of more complex, advanced operations including: link 
function, convert function, conditional branching, automatic detection of which direction to get-up 
based on acceleration sensor input, and motion/scenario execution in different situations. 
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Cautions
The contents of this manual may be updated without prior notice due to product improvements 

and other reasons. Also, the software may be updated without prior notice. 

Software included in the product is provided as free software under the condition that it is only 
used in conjunction with our company’s products. Copyright and other legal rights belong 
to Kondo Kagaku CO., Ltd. Distributing, publishing, reverse assembling and other reverse 
engineering activities without prior permission in writing are strictly prohibited. 

Company and product names in this manual are all registered trademarks of Kondo. 

The underlying premise of this manual is that the products are to be used in Japan. Use of the 
products outside of Japan, or exporting the products, may require permission or approvals 
under the related laws and regulations.

The software applications covered by this manual operate with Microsoft Windows2000 or XP 
SP2. Operation with emulators or other virtual software is not supported.

The Kondo Service Department provides maintenance service after purchase, and accepts 
questions by telephone or E-mail. (support@kondo-robot.com) 

However, please understand that it may take some time to reply questions via E-mail.

This manual is a basic version of the control manual for RCB-3 and covers its use with KHR-
series robots. The RCB-3 can be used with servos that use serial communication control 
methods like the KRS-4014HV. However, this manual assumes that all servos are used by 
PWM method. Information on servo operation using the serial method will be published on 
the Kondo Robot website. Please refer to it as necessary.

Some manual sections may include sample motions as examples, however, the sample 
motions may not necessarily be provided with the product itself. 

Also, the RCB-3J sample motions used with the KHR-2HV and published on our website 
will not operate properly if you try to use them with the RCB-3 without conversion. Please 
convert any RCB-3J motions for use with the RCB-3 using the appropriate methods 
documented either in this manual or on our website.
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H a r d w a r e
RCB-3 Characteristics 

The RCB-3 is a third-generation control board developed by Kondo for use with the KHR-series humanoid robots. 

· Renesas Technology Corp. M16C CPU, capable of high speed command-execution. 
· 24 ports that can be configured for output or input and support PWM as well as H/L signals
· High Speed (115200bps) Serial Port used for PC communication and a low speed serial port used for 

communication with a Kondo wireless radio control receiver.
· 3 analog sensor ports. Analog sensor inputs from gyros, accelerometers or other sensors can be mixed 

and used to control multiple servos  or to control conditional branching during motion sequence execution.

Part Names 
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High-speed serial connector

 

Connector Types 
Power supply connector

The correct power supply polarity is shown 
in the picture. 
Please check the polarity carefully when 
using connectors that were purchased 
separately.

Output connetors 

Output 1-8 G
N

D

V
C

C
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ignal

Output 9-16 G N D

V C C

S i g n a l

Output 17-24 G
N

D

V
C
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The RCB-3 board was designed so that the negative (GND) terminals are 
always positioned towards the outside edge of the board. Positive power 
source terminals are directly connected to VCC. Output signals from the CPU 
(PWM, serial, H/L, etc.) are 0-5V output levels. 

Interface (input/output)
Output ports: 24  (Supports PWM/serial servo 

output, H/L, ICS control, etc.). 
Input ports 

High speed serial port (1) 
Low speed serial port (1) 
Analog input ports (3)

Capacity 
Motion sequences: 80 (max) 
Objects per motion: 255 (max) 
Note: The actual number may be decreased 
slightly based on the motion sequences used 
Scenarios: 5 (max) 
Scenario capacity: 200 motion sequence  
references (max)

Operation voltage: 9-12V 
Note: Can be operated with a 6V power source 
using the Kondo Booster-3 option board.

Specs

AD input connectors 
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Regulated 5V power is available via the VDD pin of the AD 
input connectors. A total of 50mA can be supplied to sensors 
from the three AD input connectors. 

High speed serial connector

1
2

3

To communicate between a PC and the RCB-
3, use the Serial USB adapter supplied or  the 
ICS-PC Interface 2 adapter (previously used 
with the Kondo RCB-1). In either case, please 
confirm the COM port number assigned by the 
PC operating system. For the high speed serial 
connector/cable, black is the GND while the 
other two (red and white) are both signal lines.

Low speed serial terminal

1
2

3

The low speed serial connector is typically 
used for remote control operation with the 
KRR-1 wireless radio control receiver, or 
the KR-1 in conjunction with the KRR-2 
connected to the KRT-2. The remote control 
setup is covered in detail later in the manual.

Black is GND, red is VCC, and white is the 
signal.

123

Dimensions: 35×45(mm) 
Maximum height: 14.5mm
Weight: 12g
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l
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S o f t w a r e
RCB-3 Power 

The RCB-3 does not have an integrated power switch. In order to switch it ON/OFF, you need 
to connect, or disconnect, a power source (Ni-Cd battery for example) to the power source 
connector. You can also prepare an external power switch. 

Install

Install the HeartToHeart3 software following the directions below. 
There is no specific installation wizard provided, it is only necessary to copy the necessary 
files to the hard disk on your PC.

Before installing the application software, the Serial USB Adapter and its driver software 
has to be installed on the PC. Please read the Serial USB Adaptor manual and follow the 
installation instructions.

Serial USB Adapter Installation

H2H3 Software Installation 

1 Open the Software folder on the included CD-ROM. 

2 [HTH3.EXE], located in this folder, is the primary 
software application. Copy this file to the PC hard-
disc.

Note: You can not directly run the software from the CD-ROM since the 
program needs to modify initialization parameter files stored in the same folder.
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S o f t w a r e
Software Start-up

Main Menu Command Menu Communication Setting
Tool Menu

Object Menu 

Status Display

Message

The window above will appear when you start the software. Please refer to the diagram above for the 
names of each part of the software. The operating icons are logically divided into four functional groups. Not 
including the main menu group, the other three icon groups can be displayed as floating windows using drag 
and drop.   

D a t a  S h e e t

D a t a  S h e e t

D a t a  L i s t i n g 

Example: Displaying icon group tool 
bars as floating windows. 
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S o f t w a r e

Main Menu

L o a d S a v e

Environment Set-up

I n f o r m a t i o n E x i t

Used to load previously saved data. 
Clicking on the Load icon opens a 
dialog box to select the data file to be 
loaded.

Used to save the current data.  Select the 
desired folder and enter a file name..  

Used to set-up the applications operating parameters. 

Size - Sets the Width and Height of the Datasheet display.

Grid interval - Sets the smallest grid interval for object positioning on 
the Datasheet.

“Display file icon” - The check box toggles display of the RCB file 
icon associated with the file. 

Display - The four check boxes toggle the display of each icon menu 
group.

Apply - Click to apply new settings.

Displays application 
information 
including the 
version. Close the 
window by clicking 
anywhere in the 
main window, or on 
the X in the upper right corner.

Click on this icon to 
close the application. 
A confirmation dialog 
box will appear. Note: 
Be sure to save any 
changes to your data 
prior to closing the application.

Note: New data loaded is appended to any data 
already existing on the current Datasheet. Existing 
data is not automatically overwritten. Therefore, 
if you only want to load new data it is important to 
delete any existing data first.
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S o f t w a r e

Analog 

ICS

The RCB-3 supports three analog input ports. The 
Analog setting controls how the analog sensor signals 
are used by the RCB-3. 
There are two analog input operating modes:
1. Real-time mixing 
2. Motion Interrupt
1. Real-time mixing  

Applies multipliers to the analog sensor signal and 
then feeds the result to designated servo channels. 
This is typically used with gyro sensors for balance 
correction and stability.

      2. Motion Interrupt  
Sets the analog sensor signal trigger levels to 
generate an interrupt and execute assigned motions.  
This is useful for automatically triggering a ‘get up from 
fall’ motion sequence using an accelerometer sensor.

The RCB-3, when used with H2H3, supports setting the servo 
ICS parameters for all channels.

Note: After any servo ICS parameter modification the ICS 
Setting window needs to be closed, and the RCB-3 power must 
be cycled off and then back on before the changes take effect.

To read the current settings from the RCB-3, click on the Read 
icon in the upper left corner of the window.

Double click on the desired channel to open its setting window 
and change the settings. The Initialize icon resets the settings 
to their default initial values. After setting the desired values, 
close the ICS Setting window and cycle the RCB-3 power off 
and then back on to apply the new settings.

Note: To modify ICS settings for an ICS2.0 enabled servo, like 
the KRS-4014, the servo mode first needs to be set as a Serial 
Servo in the Option Setting window.

Tool menu
Note: To open any of the tool menu windows the RCB-3 has to be turned on and properly connected 
to the PC.

Trim Option 
Adjusts the trim for each servo connected to the 
24 output ports.

Controls the RCB-3 option settings that are covered in 
other sections of this manual.
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S o f t w a r e

Communication setting

Receiver

Table (Data Table) 

Monitors analog signals received from a transmitter. 
Up to 4 analog signals (1 byte each)are supported. 
(Older version only supported a single 2 byte analog 
signal).

Click on the Read icon in the upper left corner of the 
window to load the existing Data Table from the RCB-
3. This will display a list of the motions and scenarios 
including their names and dates.

Note: When you first start up HTH3 the Data Table 
Display will be blank. It is not automatically synced with 
the RCB-3. Please click the Read icon to load the current 
Data Table.

Sync COM Port

When the SYNC box is checked, any servo 
position changes made in the application are 
automatically sent to the RCB-3 and will cause the 
corresponding servo to move on a real-time basis. 
If the box is not checked, then the RCB-3 is only 
updated when the Send icon is clicked

Sets the communications port (COM port) to be used. 
The Serial USB Adapter is recognized by the Windows 
operating system as a virtual serial port. To communicate 
with the RCB-3, H2H3 needs to be set to the virtual 
serial port assigned by the Windows operating system. 
The virtual serial port assignment on your PC can be 
determined using the Windows Control Panel. Refer to the 
Serial USB Adapter manual for details. 
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S o f t w a r e
Objects Menu 

Select

The Objects Menu is used to create and edit motion and scenario sequences on the Datasheet.

Used to select objects on the Datasheet. The 
Select mode is accessed by clicking on the icon, or 
pressing the keyboard Esc key.

G r i d

If the GRID box is checked, objects will snap to grid 
intersection points on the Datasheet. If the box is 
unchecked, then objects can be freely positioned.

Start Flag
Determines the motion sequence Start (initial) object 
to be executed first.
If there is more than one motion sequence on the 
Datasheet, then only the motion with a designated 
Start Flag will be executed. This will be covered in 
more detail later in the manual.

POS (Position) Object 
POS Objects are used to modify servo position 
settings or channel parameters. The window to the 
left will appear when you double-click on a POS 
Object. Any changes made become effective when 
the window is closed.

POS Object Window explanation:
Each servo panel, labelled CH1 through CH24, controls the settings for the corresponding 
RCB-3 Output channel. These used to set the operating modes and positions for 
connected devices, usually servos. Right clicking on a panel will display the set-up menu 
shown on the right.

Set-up Menu explanation:
NONE - Resets the panel to the default mode with nothing displayed. 
SERVO - Sets the panel to servo mode, and displays the servo position slider bar control. Servo position can 
be varied by clicking on the arrows at the left and right of the slider bar, dragging the slider to the left or right, 
or by typing the desired position value in the box to the left of the slider bar. Note: Typed numeric entries do not 
become effective until the Enter key is typed.
The numeric value represents a scaled version of the servo angle, and varies based on the servo models being 
controlled. For example, for the KRS-78x and KRS-23xx series, each increment represents approximately 0.35 
degrees of rotation. For the KRS-4024HV servos, each increment is approximately 0.5 degrees, and for the 
KRS-4014HV servos, it is approximately 0.52 degrees (with PWM).
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S o f t w a r e
FREE → puts the servo free rotation mode (undriven). Note: This only applies to Kondo robot servo products.
SET1- SET3 → Applies sets of servo characteristics. 
Changes servo characteristics like compliance and speed under program control. Note: This only applies to 
Kondo robot servo products. For the KRS-4013HV and KRS-4014HV servos the setting panels do not appear 
in serial mode.
H  →    Outputs 5V signal level 
L  →     Outputs 0V signal level 
Display   →     Used to display or hide each panel. 
Color →     Sets the panel display color 
Name   →     Allows changing the assigned panel name (CH1-CH24)  
Display Scale Factor   →    Scale factor for displaying the servo position
For example, to have 1 display count correspond to 1 degree of rotation:
 KRS-78x series and KRS-23xx series, set to 2.9. 
 KRS-4024HV, set to 2.0. 
 KRS-4013HV and KRS-4014HV, set to 1.92. 
Set Home position  →  ¨ Sets the current pose as the Home Position.
Panel Lock   → Locks and unlocks positioning of the panel within the POS window.

SPEED    →     Sets the POS object execution time. Increments correspond to the current RCB-3 setting. For 
example, when the RCB-3 is set to 15 ms, each Speed increment corresponds to 15 ms.                        

LINK   →    Allows complex modifications to POS objects including channel swapping, scaling, and others. This 
is covered in detail on page 49.

Write  →  Sends the current pose to the RCB-3 and causes it to be executed. Note: This is non-
functional when the SYNC box is checked.

Read →  Reads the current pose from the RCB-3. Note: This is non-functional when the SYNC box is 
checked.

Home position →Returns the RCB-3 (and robot) to the previously set Home Position pose.

Trim position → ¨ Returns the RCB-3 (and robot) to the previously set Trim Position. The trim position 
is typically defined as all active servos set to 0 values.

Sleep → - Toggles the servos between sleeping (inactive) and awake (active) modes. Note: Please be 
careful of abrupt servo movement when returning from the sleep mode.

Snapshot → Captures the current servo positions. Used by the Teach function which is explained in 
detail on page 41. 

Increment LINK  → Used by the LINK function which is explained in detail on page 41.
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Captures the 
current value of 
the designated 

analog input channel to be used by a subsequent 
CMP object for conditional branching.

Stores an integer 
value that will be 
used later in the 

motion sequence by the CMP object to determine 
conditional branching. This is explained in more 
detail later.

S o f t w a r e
SET Object

Used to preset a wide range of variables that control conditional execution of the motion sequence.
Double click on the SET Object to display the SET window below. Changes made to this window become 
effective when the window is closed.

Captures the position values for servo channels 
that were in the FREE mode during the preceding 
POS object. This becomes the starting position 
for the next POS object.

Presets the loop counter and is used in 
conjunction with the CMP Object. This is 
explained in more detail later.  
Note: Typed numeric values do not take effect 
until the Enter key is pressed.

Jump:  you can jump to motion scenario that you have selected from the pull-down menu from the active 
motion scenario.  You cannot return back to the original motion from the second motion that you have just 
jumped to.  

Call:  Triggers a call to the selected motion or scenario. Note: The called motion can return to the original 
motion using the “Call Return” function described below.
Call Return : Used in conjunction with the “Call up motion/scenario” function above. Triggers a return to the 
calling motion sequence.

Used to toggle the analog sensor 
controls on and off. Note: The displayed 
wording (ON/OFF) will change based on the 
check box status.

Changes the time base interval for motion execution. 
Default is 15 msec
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S o f t w a r e

CMP Object (Compare - Conditional branching)

Flow Wiring Branch Wiring
Motion sequences are created by placing objects 
(POS, SET, CMP, etc.) on the Datasheet, then ‘wiring’ 
them together in the desired sequence using this 
tool. This is similar to creating a flowchart.

Similar to the Flow Wiring tool above, the branch 
wiring created with this tool defines the motion 
branch to be executed when CMP object conditions 
are satisfied. Note: Branch Wiring always begins at 
a CMP object.

Compile
Motion sequences are created and edited on the Datasheet by placing and wiring objects. The motion 
sequence information is converted into numeric data that the RCB-3 can utilize when the Compile tool 
icon is clicked. The compiled data can be viewed by clicking on the Data-List tab. Note: This is done 
automatically when the data is written to the RCB-3.

With HeartToHeart3, the individual robot poses that make up a motion are created 
by placing POS objects on the Datasheet and adjusting their settings. SET and CMP 
objects are added to control movement conditions and conditional branching. The 
objects are then connected in the desired sequence using the wiring tools.

Used to set the scale factors for applying analog sensor inputs to individual servo channels. Double-click 
on the MIX Object to bring up the MIX setting window. Any changes made become effective when the 
window is closed.

The CMP Object is used to compare pre-set conditions and trigger conditional branching when the 
conditions are satisfied. Logically, it is equivalent to a [jump if ***] where “***” is the condition being 

tested.
For example, the loop counter is pre-set by a SET object, 
then, tested by the CMP object. If the loop counter value 
is 0 the conditional branch is executed. Otherwise the 
loop counter is decremented.
The Comparison Register can also be preloaded by a 
SET object. In that case, the CMP object compares the 
Comparison Register value to the change in the specified 
analog sensor input. If the amount of change is greater 

than the  Comparison Register value the conditional branch is executed.
“Remote Code” refers to the numerical value received from the wireless radio control, and is tested by 
the CMP object to trigger conditional branching. 

MIX Object (Mixing setting)

CH1-CH24 -> Selects the analog sensor input and scale factor to be applied to each servo channel.
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S o f t w a r e
Command menu

Home posit ion
Clicking this icon causes the robot to automatically return to its pre-set Home position. If the Home 
Position has not been pre-set with a POS object, then nothing will happen.  
Note: Please be careful since the servos may move abruptly.

W r i t e
Compiles and writes the existing Datasheet motion 
data to the RCB-3. Use the pull-down menu to select 
the RCB-3 memory slot (M1-M80) to store the motion 
data, then click ‘OK’.

Reads existing motion or scenario data from the 
RCB-3 and displays it on the Datasheet. Use the 
pull-down menu to select the desired motion or 
scenario to be read, then click ‘OK’.

R e a d

D e l e t e

Deletes selected motions or scenarios from the 
RCB-3  memory. Select the motion or scenario to be 
deleted using the pull-down menu, then click ‘OK’

S t o p

P a u s e

P l a y

 Stops currently playing motions, or scenarios

Pauses the current motion or scenario. To resume, press the Play button.

Selects and plays the desired motion or scenario. Click on 
the play button, then select the desired motion or scenario 
to play, then click ‘OK’.

Trim posit ion
Clicking this icon causes the robot to automatically return to its Trim Position. The Trim Position is 
defined as all servos set to 0 rotation values. If the Trim Position has not been preset with a POS 
object, then nothing will happen.
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S o f t w a r e
M e s s a g e Displays a program status message, along with the time.

Data sheet
The Datasheet acts like a canvas for the creation and editing of motions and scenarios. Objects are selected 
from the Object menu and placed on this canvas. To edit the data and parameters associated with each 
object, double-click on the object to open its editing window.Selecting the EDIT tab at the top of the Datasheet 
displays the Datasheet canvas with the current motion objects. The tab also shows the Data Name assigned 
to the motion (see Data Dialog below).
Selecting the Data-List tab at the top of the Datasheet displays the motion’s compiled data which is sent to 
the RCB-3

Double-clicking on a blank area of the Datasheet will display the Data 
Dialog window. Enter the name you want associate with the motion in the 
Data Name text box. Note: This is the name that will appear in the Data 
Table listings.
The Control Input box is used to assign an integer code to the motion 
that corresponds to the remote control button codes. The default value is 
65535 (no button). The Capture button is used to automatically capture 
transmitted remote control button codes. This process is explained in 
more detail later in the manual.
Click OK to save any changes to the data. Note: This data is not updated 
on the RCB-3 until the motion is written to the controller.

D a t a  d i a l o g

Right-clicking on a Datasheet object displays the menu shown on the right. 
The menu includes object editing, conversion, and property functions including 
the object name and display color

Release Selection: Deselects any currently selected objects.
Copy: Copies selected objects to the application clipboard
Paste: Pastes copied objects from the application clipboard to the Datashee

Color: Sets the display color for selected objects.
Properties: Used to edit the object name and to set the width 

and height of the object on the Datasheet. Click “Apply” to 
update the object properties.

Delete: Deletes the selected objects.

D a t a s h e e t  O b j e c t s

A data dialog opens when you double-click on the data sheet.

Convert:  Opens the Convert window. 
Insert: Used to automatically insert new POS objects between two existing and 

connected POS objects on the Datasheet. Multiple new POS objects can be 
inserted (1, 2, ..., n). Servo positions and SPEEDs of the new objects are linearly 
interpolated from the selected POS objects.

Save: Saves the selected objects.
O p e n :  R e a d s  p r e v i o u s l y  s a v e d  o b j e c t s  a n d  i n s e r t s  t h e m  o n  t h e  D a t a s h e e t . 

Note: Saved objects have the same filename extension as other H2H3 files (*.RCB) but use a 
different file format. To avoid confusion, please create a separate file folder for storage of saved 
objects.
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Introduction
This section covers basic operation and the creation of a simple motion. The RCB-3 is an 
advanced control board with a rich selection of functions. However, the process to create a 
simple motion is very straight forward.

1 When using H2H3 for the first time, please refer to the installation section of this manual to install the serial 
USB adapter and install the H2H3 application software. Note: The communications port (COM port) number 
assigned by the PC operating system and the COM port number selected in Step 4 below must match for H2H3 
to communicate with the RCB-3.

2

3

With the RCB-3 power off, connect one servo and the serial USB connector to the RCB-3. Power-up the RCB-
3. The green LED will light up for approximately two seconds.

4

5

Open the H2H3 software. The application status bar 
will display the current system time and the COM port 
status (see screenshot to the right). 

Select the COM port for H2H3 to use. For example, if the port assigned 
by the PC operating system is COM6, and COM6 is selected on the pull-
down menu, then the status bar will display “COM6 OK”.

If a non-existent COM port, or a COM port that is being used by 
another application, is selected, then the status bar will display a 
message indicating that the selected port cannot be used. Please 
select the correct COM port.

Note: To determine the COM port number assigned by the PC operating system, please refer to the Serial 
USB Adapter manual. 

Servo connection and control – Setting the default servo position

Check the SYNC check box. When the SYNC box is 
checked, then any changes to servo settings within 
H2H3 will automatically be transmitted to the RCB-3 
and the connected servo.
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7

8

6 6 Create a POS (Position) object on the 
Datasheet to control the servo. To do this, first 
click the POS icon on the Object menu, then 
click in a blank area of the Datasheet canvas. A 
new POS object will be created.

Double-click on the new POS object to open 
the POS window. Initially, all RCB-3 output 
ports are set to 0V (L). To operate a servo, the 
corresponding output channel needs to be set to 
SERVO. Right-click on the panel connected to the 
servo (CH1 for example) and select SERVO

The servo panel will display the slider bar. Moving the slider will cause the servo to change positions 
accordingly. Note: Always use the slider to return the servo to its initial position when removing or installing 
parts like horns attached to the servo.

Using this method, the servo operation is confirmed. Repeat these steps to change servo positions and 
movement.

Caution: The servo will instantly move when the panel is switched to the SERVO mode. Please 

be careful of the servo horns and other parts attached to the servo.

Note: While using the POS window, if you click 
on any other H2H3 window the POS window 
will automatically close. Double-click on the 
POS object again to reopen the POS window if 
necessary. 

Note: The process above assumes the servo is being used in PMW mode. Please be aware 

that using the servo in serial mode has some differences.
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Preparing the Trim Position

The Trim Position is the basic reference position 
for all robot motions and movement. In general, 
humanoid robots stand upright like a human being. 
However, to consistently attach, or replace, parts 
of the robot to the servos, a repeatable reference 
al ignment needs to be predetermined. This 
alignment will differ based on the robot model.

Setting the servo position to 0 (center of rotation) 
prior to attaching any parts establishes a repeatable 
reference alignment and stable robot while making 
it easier to change or replace parts later. If, for some 
reason, parts cannot be easily attached to the servo 
in its center position, then change the servo rotation 
and attach the parts.

1
Each servo should be set to its initial 0 position using the steps above. The following section 
assumes that all of the servos are connected to the RCB-3.

2
One by one, set each connected servo 
panel to the SERVO mode, and set 
their positions to 0 using the slider bars. 
Please be careful since the servo will 
abruptly move when the panel mode is 
changed.

The screenshot on the left shows a 
typical example with all active servos set 
to their 0 position.

Once all servos have been set, then 
close the window.

Note

Change Output Mode to SERVO 

Note: The servos will not move unless the SYNC 
check box is checked.
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3

Servo numerical display values 

Servo actual numerical working value.

4

Setting the Trim Position

Returning to the Trim Position 
To return the robot to its Trim Position either click on the Tool menu Trim Position icon, or the POS window Trim 
Position icon.
 Note: When the Trim Position icon is clicked the robot will momentarily go into free mode (servos un-powered) 
and will then move to the Trim Position at a SPEED of 100.

Click the Trim icon in the tool menu to 
open the adjustment window.

Each servo channel has a slide bar to adjust its 
Trim Position.

The actual numerical values will differ based on 
the robot model.

There is a limit to the range of trim adjustment 
that can be applied using the adjustment window 
sliders.

Also, even if a number is within the allowable range, there may be a limit to the range of the motion that can 
be made with the slider.

Note: The Trim Position icon can only be used after the Home Position is set. (Details on the next page)
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Setting home position

1 Open the POS Window

The Home Position is a user definable robot posture. In contrast to the Trim Position which 
is an upright reference posture use for adjustment and alignment of the robot, the Home 
Position is the base posture from which the user can create motions. For example, the robots 
knees and/or arms could be bent slightly.

2 Create pose 

3 Set as Home Position

4 Click Home Position icon

Double-click on the POS1 object to open 
the POS editing window. 

Adjust the servo slider bars to create 
the robot pose to be used as the Home 
Position

To return the robot to its Home Position, either click on the Tool menu Home Position icon, or the POS window 
Home Position icon.

Note: The Trim Position icon can only be used after the Home Position is set.

Right-click on any of the active servo 
panels, then select “Set Home Position” 
from the menu.
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Create start up motion

The RCB-3 can be set-up to automatically execute a predefined Start-up Motion when it is initially powered-on. 
Typically, this motion is created to return the robot to its Home Position.

Note: The following material assumes that the Home Position has already been set. This process only applies to 
KONDO robot servo products.

1 Create a POS Object (POS1)
Using a blank Datasheet, select the POS icon on the 
Object menu, then click on the Datasheet canvas to 
create a new POS object (POS1).

2 Edit POS1 
Double click positioned POS1 and open POS window.  On the 
POS window, make all the setting of the channel that the servo 
is connected to [FREE].

3 Set SPEEED
Using the SPEED slider bar, set the SPEED to 2. 

4 Create a SET Object (SET1) 
Select the SET icon on the Object menu, then click on 
the Datasheet canvas to create a new SET object.

Edits to the settings of POS, SET, MIX, and CMP 
objects take effect when the editing window is 
closed.

Note: Tool selection status is automatically cleared each time objects 
like POS, SET, MIX, and CMP are positioned on the Datasheet. To 
create multiple objects it is necessary to click the desired object type on 
the Object Menu each time.

Note: Setting the SPEED lower than 2 may result in improper operation with some 

robot models.
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5 Editing SET1

Double-click on the SET1 object to open the 
SET editing window.

Select the “Capture FREE Servo Values” 
button

6 Create POS2 

7 Edit POS2

Select the POS icon on the Object menu, then click on the 
Datasheet canvas to create a second POS object. [POS2]. 

Double-click on the POS2 object, then set 
the object SPEED to 100. Click the Home 
Position icon to move the robot to the Home 
Position established earlier.

Note: If the SPEED value is very small the 
servos will move abruptly and could pose 
some danger. Always start with a large 
SPEED value like 100 first.

8 Connect the Objects
Select the Flow Wiring icon on the Object menu, 
then connect the Datasheet objects in order – POS1, 
SET1, POS2. Once the Flow Wiring tool is selected it 
stays active until another tool is selected.
To connect the Datasheet objects, click on the first 
object. A red line will appear as the mouse is moved. 
Move the mouse over the next object to be connected, 
then click and the connecting line will appear. Repeat 
this process to connect all three objects.

Designate the Start Position 
Each motion needs to have a designated Start Position 
so that the RCB-3 knows where the motion execution 
should begin. To designate the Start Position, click on 
the Start Flag icon on the Object menu, then click on 
the first POS object to be executed in the motion. A 
red Start Flag will appear on the object.
Note: The Start Flag tool selection is modal and isn’t 
deselected until another tool is selected. Each motion 
can only have one Start Flag.

9
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Save the Motion11
The new motion can be saved to the PC hard disk. Click on the 
Save (Diskette) icon on the File menu, then select the disk folder 
and file name to save the motion.

Enter the Motion Name10
Double-click on a blank area of the Datasheet to open the Data 
Dialog window. Enter a name for the new motion, like “Start Up 
Motion”, for example. Then click the OK button. The new name 
will appear in the Datasheet EDIT tab.

A save dialog will appear and you 
can enter a name.

Confirming the Motion Destination Destination12
To avoid writing over other motions or 
losing data, before writing motions or 
scenarios to the RCB-3, always confirm 
the current RCB-3 Data Table listing. 
Click on the Table icon to open the Data 
Table display. Click on the Read icon in 
the upper left hand corner of the window 
to retrieve and display the current Data 
Table from the RCB-3.
As motions or scenarios are written to 
the RCB-3 they will appear in the Data 
Table listing.

Note: The Data Table can be simultaneously 

displayed along with other windows.

Start Up Motion
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Write Motion Data 13

Click the “Write” icon to write the current 
motion data to the RCB-3 controller. Select 
the desired RCB-3 memory slot to store the 
motion, then, click “OK”. Memory slot M80 is a 
typical choice for storing the Start-Up Motion.

Note: The RCB-3 will momentarily go into 
Sleep mode as the motion is being transmitted. 
Be careful to avoid any problem, or the robot 
falling, since the servos may temporarily go 
slack.

Register the Start-Up Motion14

Click the Option icon. Use the “Power-up motion” pull-
down menu to select the Start-Up motion. Changes to this 
window take effect when the window is closed.

After completing the Option setting and closing the 
window, power the RCB-3 off and then back on 
again. Confirm that the Start-Up motion is executed 
when the power is restored.

Note: The example Start-Up motion explained above is effective for KONDO RED version servos.  
Ideally, servos should initially move slowly when first powered up. However, there is no industry standard power 
up position for servos so some servos may move abruptly. The Start-Up motion above initially frees the servos, 
then, slowly moves them from their unknown positions to the Home Position. Using this technique provides safe 
and easy movement to the Home Position.
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Creating and Playing Motions
The same basic process used to create the Start-Up Motion can be used to create other motions. Here is a brief 
summary of the process:

1
Connect the RCB-3 to the PC, and power-up the robot. If the Start-Up Motion has been set, then each servo 
will slowly move to the Home Position.

2
Start the H2H3 software, select the appropriate COM port, and click the SYNC check box.

●Make the settings on connection port which corresponds to the port number 
of the connected interface port.

●Put a check on synchronization switch.  The changes you will make to  each 
servo will immediately reflected.

4
Motions are created by placing and 
connecting a series of objects on the 
Datasheet canvas.

Simple motions can be created by 
clicking on the POS icon and then 
the Datasheet to place POS objects. 
The POS objects are then wired in the 
desired play sequence using the Flow 
Wiring tool.

Click on the Start Flag icon, then the 
POS object that represents the Start 
Object of the motion. 

Data sheet

Connect the RCB-3 and turn on the powe

Start the H2H3 Software 

Create a Motion

3 Read the Data Table 
When the H2H3 software initially starts it doesn’t know the current RCB-3 Data Table information. Click the 
Table icon on the Tool Menu to open the Data Table, then, click the Read icon to update the H2H3 Data Table 
display with the current RCB-3 status.
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4

5
Write the created motion to the RCB-3. The motion 
can also be saved on the PC as a file.

Write the Created Motion 

Edit the Motion Objects

6 Play the Moti
Click on the Play button and select the motion to be played from 
the pull-down menu. Use the Pause and Stop buttons to control the 
playing of the motion.

Note: The RCB-3 data memory is structured as 80 motion slots (M1-M80) and 5 scenario slots (S1-S5).  A 
single motion slot can contain a motion with up to a maximum of 30 objects (POS, SET, MIX, or CMP). If the 
motion is larger than 30 objects, a confirmation message will appear. Selecting ‘Yes’ results in the remaining 
objects being written into sequential memory slots.

M o t i o n  D a t a  C a p a c i t y

The robot moves by sequentially assuming 
postures defined by the motion sequence 
objects. The parameters for each motion 
sequence object are edited to define the robots 
postures and speeds during the motion.
Double-click on each POS object to open its 
editing window. Adjust the individual servo 
positions using the slider bars, or by entering 
numeric values, to create the desired robot 
posture.Adjust the playing speed of the POS 
object using the SPEED slider bar.
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Customize the POS Editing Window 
The layout of the POS Editing Window can be customized to make it easier to use.

Double-click on a POS object to display the 

POS Editing Window.

Right-click on a blank background area of the POS Editing Window to display the 
customization menu (see left). 

Use the pull-down menu to toggle the display of servo channels. For 
example, you can hide unused servo channels by unchecking them.

Panel Display

Panel Lock 
The window positioning of each servo panel can be unlocked so that the 
panels can be moved. For example, a typical window layout for a 21 servo 
robot is shown in the screenshot below. Each servo panel was moved to 
correspond with the physical location of the servo being controlled. 
Note: Be sure to relock the panels once they are in the desired positions.
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The POS Editing Window background color can be changed using the pull-down Color 
menu. In addition, a BMP picture file can be used as the window background using the 
‘Background Image’ menu option, and toggled off and on using the ‘Display Background’ 
option.

The display color for individual servo panels can be modified by right-clicking and selecting 
the desired color from the menu.

Panel Color Example
Panel Name Window

Display Rate Setting 
The numeric values displayed in the servo panels are expressed in terms of incremental rotation based on 
the servo resolution, not angular degrees. To display the values in approximate degrees a display scale 
factor can be applied using the Display Rate Setting option. Click on this option to display the Display Rate 
Setting window. Enter the appropriate scale factor for the servo panel to be modified.
Typical Scale Factors:
KRS-2350HV servo, PWM mode, 180 degree range = 0.345
KRS-4014HV servo, PWM mode, 270 degree range = 0.520
KRS-4024HV servo, PWM mode, 260 degree range = 0.500
moving servo (KRS-4024HV) --> 0.5

Setting the Background and Servo Panel Colors 

Click on the Name option to display the Panel Name Window. This allows 
the replacement of the default names (CH1, CH2, ...) with user defined 
names.
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Customized POS Editing Window Example

In the example below, a rear view of the KHR-2HV was used as the POS Editing Window 
background, and the servo panels were positioned over the corresponding servos in the image.

Rear and front images of the KHR-1HV for use as backgrounds can be found in the RCB-3 folder.
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Wireless Remote Control Set-up

Remote control of the RCB-3 is typically implemented using two methods. The most common method (explained 
below) uses a standard KONDO button style control box (KRT-1 or KRT-3) connected to a KRC-1 transmitter 
which sends signals to a KRR-1 receiver mounted on the robot and connected to the RCB-3.

1 Connect the wireless receiver (KRR-1 in this example) to the RCB-3 low-speed serial input port.

2 By default, the RCB-3 is set to ignore received signals. Its option settings need to be modified before it will 
recognize the remote control commands.

Click on the Option icon to open the 
Option Editing Window. Click to check 
both the “Enable remote control” and 
“Enable KRC-1” check boxes.  Close the 
window to make the changes effective.

Note: In this example the use of a KRC-1 transmitter 
has been assumed. However, the same process 
needs to be followed when using other transmitters 
or configurations including the use of the RCB 
Commander application with a PC.

1
2

3
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3 Next, specific buttons on the remote control need to be mapped to the corresponding motions for the robot to 

play when the buttons are pressed.

Click on the Data Table icon to display the Data 
Table, then, click on the Read icon to load the 
current RCB-3 data.
Double-click on the motion to be mapped in 
the Data Table. The Data Dialog window will be 
displayed. Make sure that the remote control is 
turned on, then, press and hold the button to be 
mapped.

Once the data dialog is displayed, turn on KRC-1 
and let it discharge radio waves.  Then, hold down 
the button that you wish to designate.
Click on the [receive] button on the data dialog 
while still holding down.
Setting is complete once the number on the 
control input is changed.  Now you can release the 
transmitter button.
Settings will be written  into RCB-3 when the data 
dialog closes.

Click on the Data Dialog ‘Capture’ button while continuing to depress the remote control button.  The value in 
the “Remote Control Code” box will change to display the received remote control code value. At this point, 
release the remote control button, and click OK to update the mapped motion settings.

It’s good practice to use the Data Table method to update the key to motion mapping, then load the 
corresponding motions from the RCB-3 and save them to the PC.
The functionality described in this manual so far is basically similar to the older RCB-1 robot controller, however 
the RCB-3 functionality can be used in many more advanced ways.

Note: This is the recommended mapping method. It is also possible to open the Data Dialog Window by 
double-clicking on a blank area of the Datasheet. However, any changes made using that process will not 
become effective until the current  motion is written to the RCB-3.
Note: When mapping remote keys to motions using the Data Table, changes are automatically updated to 
the RCB-3. Any previous mapping is overwritten. In contrast, mappings made using the Datasheet and Data 
Dialog directly only modify the mapping within H2H3 and are not automatically updated to the RCB-3.
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The KRC-1 remote control key mapping table with the transmitted key codes is shown below 
for use with the RCB-3.

Remote Control Values

↑
←
↓

←

→
△

□

×
○

↑ ↑
→

←
↓ ↓

→
×

□
×

○

△
○□

△

Shift2
Shift1

Shift4
Shift3

KRC-1 Button Layout 

Recommendations: 

In almost all cases it is best avoid assigning the 
value of “0” to a motion. Because “0” corresponds 
to no button being pushed, the RCB-3 may play 
this motion continuously.

When  two  o r  mo re  bu t t ons  a re  p ressed 
simultaneously, their numerical values are added.

Example

RCB-3 Control input value table
 No shift shift １ ２ ３ ４

↑

↓

→

←

△

×

○

□

288

272

256

96

80

32

64

16

10

9

8

6

5

4

2

1

0

800

784

768

608

592

544

576

528

522

521

520

518

517

516

514

513

512

1312

1296

1280

1120

1104

1056

1088

1040

1034

1033

1032

1030

1029

1028

1026

1025

1024

2336

2320

2304

2144

2128

2080

2112

2064

2058

2057

2056

2054

2053

2052

2050

2049

2048

4384

4368

4352

4192

4176

4128

4160

4112

4106

4105

4104

4102

4101

4100

4098

4097

4096

←
↑

↑
→

←
↓

↓
→

×
□

×
○

△
○

□
△

shift shift shift

No button



35

Intermediate
Gyro sensor 

Gyro sensors are used to detect changes in the robot’s posture and to apply correction to the 
corresponding servos. In older designs, a gyro sensor unit was directly inserted between the 
controller board and the servo. That approach restricted the gyro correction to a single servo or 
set of two servos, and applied the same correction factor to each of the servos.
In contrast, the RCB-3 supports up to 3 gyro sensors (KRG-3) that can be directly connected to 
the controller board. The gyro sensor signals can be modified (scaled, enabled, 
disabled) and applied under firmware and motion sequence control to 
any combination of the robots servos. Also, the gyro settings can 
be dynamically changed while a motion is playing using SET 
object parameters within the motion.

Confirm Basic Gyro Operation 
The easiest way to confirm the gyro operation is to use the 
H2H3 Analog Settings.
Assuming that the Start-Up Motion described in the 
Introduction has already been created, turn on the robot 
and allow it to slowly move to its Home Position. Then, click 
on the Analog icon in the Command menu to display the 
Analog Settings window.
For testing purposes, select the appropriate input port tab 
(typically Input 1 [AD1]) and set the real-time mixing CH1 
pull down menu to a value of “x5”. Tilt the gyro sensor and 
the servo connected to CH1 should move in response.
In this example the gyro signal was scaled by a factor of 5, 
and then applied to a single servo (CH1). Using the same 
approach, the gyro signal can be applied to multiple servos 
at the same time, and different scale factors (gain) can be 
used. If a negative scale factor is selected, it will cause the 
servo to move in the reverse direction.
Changes made in the Analog Settings window are 
automatically saved in the RCB-3 and are executed when it 
is turned on.

Connecting the Gyro Sensor (KRG-3)

For proper operation, servo positions with a non-
moving gyro and servo positions with no gyro 
should be the same. If they are different, then some 
adjustment needs to be applied. Make sure that the 
gyro is not moving, then, in the upper part of the 
Analog Settings window (Base Level Setting) click the 
AUTO button. This will capture and store the current 
gyro signal.

Connect the gyro sensor to one of the RCB-3 analog input 
ports (AD1, 2, 3) AD input    1

AD input    2
AD input3

KRG-3
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More Practical Gyro Techniques 

The gyro set-up process covered on the previous page results in settings that take effect from the time the robot 
is initially powered up until it is shut-down. That set-up process doesn’t compensate for gyro sensor drift over 
time or drift due to temperature changes. Also, the gyro compensation is applied to all motions played, though 
this could sometimes be inconvenient. To address these situations, the RCB-3 supports advanced methods to 
dynamically manage gyro compensation. 

MIX Object Gyro Settings
Inserting a MIX object into a motion at appropriate points provides the 
ability to manage the gyro settings dynamically.
First, create a new motion making sure to save and delete any motion 
already on the Datasheet. 
Note: When creating a new motion always delete all objects on the 
Datasheet. An easy way to do this is to right-click on a blank area of the 
Datasheet and click Select All from the pop-up menu.  Right-click on the 
selected objects and click Delete, or press the DEL key on the keyboard.

Click on the MIX Object on the Object menu, and then 
click on the Datasheet to create a new MIX object. 
Double-clicking on the MIX object will display the 
object’s MIX Settings window.

In the MIX Setting window, the left column associated with 
each channel determines the type of mixing to be applied 
while the right column determines the scale factor (gain). For 
example, AD1-R indicates real-time mixing will be applied to 
the AD1 gyro sensor input.

Similar to the Analog Window setting process 
explained previously, different gain settings 
can be applied on an individual channel basis, 
and multiple channels can be compensated 
simultaneously. Also, a negative gain setting 
will result in servo movement in the reverse 
direction. MIX objects can be inserted in the 
motion sequence at any point that the gyro 
compensation needs to be modified.
Of course, actual use of this technique will 
vary depending on the robot type and motion. 
For example, for a particular motion you may 
want to have the gyro compensation active while 
the robot is walking, but less or zero compensation 
when it bends over or stands up from the floor. 
Experimentation trying several different methods is 
highly recommended.
To insure stable operation when using gyro 
compensation, the analog input values need to be 
corrected while the robot in a stable position. This can 
be accomplished by inserting a SET object into the 
Start-Up Motion (see screenshot to the right). This 
should also be done periodically if the robot is operated 
for a long period of time.
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Integrated ICS Settings Management

KONDO RED version servos support editing the servo’s ICS settings. In older designs this had to be 
accomplished via a separate software application with the control board disconnected. However, with the RCB-
3 this functionality has been integrated into the H2H3 application. 

1 Click on the Option icon on the Tools 
menu to open the Option Window.

Check the appropriate boxes for the channels whose ICS settings will 
be modified. There is no problem if channel that won’t be modified is 
selected.

Open the ICS Editing Window2

Click on the ICS icon on the Tools menu to 
display the ICS Editing window. With the 
window open, cycle the RCB-3 power off, 
then back on again to put the servos into 
ICS editing mode. Read the servos current 
ICS settings by clicking the Read icon in 
the upper left hand corner of the window.

The servo settings are displayed in table 
format. Click on individual channels to edit 
their settings.

After modifying the ICS settings, close the window, and cycle the RCB-
3 power off and back on again to return the servos to normal servo control 
mode.

Note: The KRS-4013HV and KRS-4014HV servos support the ICS2.0 standard and can be used in 
serial mode.
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Creating a Scenario
Scenarios are a simple way to play a series of motions in a consecutive fashion. For example, scenarios are a useful 
way to perform an autonomous demonstration within a given period of time.

Clear the Datasheet1
Creating a new scenario requires a blank 
Datasheet. Select all existing objects by right-
clicking on a blank area of the Datasheet, then, 
click Select All on the pop-up menu. Right-click on 
the selected objects and select Delete on the pop-
up menu, or press the DEL key on the keyboard.

Open the Data Table 2

Click on the Data Table icon on the Tools 
menu to display the Data Table Window. 

Click on the Read icon in the upper left hand 
corner of the window to read the current data from 
the RCB-3.
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Add start flag to data sheet.  Add flag to 
object that you selected and wish to be 

executed first.

A d d i n g  M o t i o n s  t o  a  S c e n a r i o3

Drag and drop the desired motions from the Data Table to the 
Datasheet. 

Use the Flow Wiring tool to connect the selected motions in the order they are 
to be played.

The wiring tools are modal and remain active until another tool is selected.

Note: To cancel a wiring operation after it has begun (red wire is 
displayed), right-click.

Note: The Start Flag tool is modal and remains 
active until another tool is selected.

Placing motions on the Datasheet causes it to be automatically recognized as a Scenario.
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Wri te  the  Scenar io 4

Double-click on a blank area of the Datasheet to display 
the Data Dialog window. Enter the Scenario name. Iit 
is also possible to map a remote control key to play the 
scenario if desired. Click OK to save the changes.

Click on the Write icon and select the 
desired RCB-3 memory slot (S1-5) to store 

the scenario, then, click OK.

Scenarios can be played, just like motions

Scenario Content and Cautions

Motion sequences contain all the information necessary to define the robots 
movements. In contrast, scenarios only contain a list of motions to be played. 
They contain no detailed information concerning the servo positions or speeds. 
Conceptually, a RCB-3 scenario is like a motion play-list for the robot.
Caution: Changes to motions called by a scenario will result in the scenario 
playing the updated motions. Please be careful to reconfirm the behaviour of 
scenarios when making changes to any motions they reference.
If there are errors in a referenced motion, the robot may not move as expected. 
Also, if there is an error in a loop (explained in the Advanced section of the 
manual), then an endless loop may occur.
When using scenarios, always carefully confirm all referenced motions.
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Using the Teach Function

The most basic method of creating a robot posture for a motion is to specify the position of each 
servo by either adjusting its slider bar or entering a numeric value. A series of postures are then 
connected in sequence to form the desired motion.
An alternative, and more effective, method is to use the RCB-3 Teach function. The servos to be 
modified are put into FREE state, then, they are manually moved to the desired posture and their 
positions are captured by H2H3. The captured positions are used to automatically set the POS 
object data.   
Note: The Teach function requires the use of KONDO Red version servos and may not be 
functional with servos from other 
manufacturers.

1

2

Create a POS object on the 
Datasheet.

Double click on the POS object to display the POS 
Editing window.

3 The LINK pull-down menu is used to define 
combinations of servos to be modified 
simultaneously as a set. Select “Setting of the 
combination” on the LINK menu to display a new 
”Link Editing” window.

4 Use the servo channel pull-down menus 
to set the desired servo channel(s) to TCH 
(teach) mode.
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5 Repeat the process to set all the desired channels to the 

TCH mode. For example, to create a LINK combination to 
be used in capturing the posture of the robots left arm, the 
left arm servo channels would be set to the TCH mode.
Enter a name to be used for the LINK combination. The new 
LINK name will be appended to the pull-down LINK menu 
and can be easily selected for future use.
Note: “TCH” has been used as the LINK name in this 
example.
When the desired editing is finished, click OK to close the 
window, and apply the changes. 

6 In the POS Editing window select the new LINK (“TCH” 
in this example) from the pull-down menu.

7 With the new LINK selected, use the following 
process:

Click on the Snapshot icon once. The servos set to TCH mode in the LINK will 
automatically go into FREE state allowing them to be easily moved manually. 
Position them to assume the desired pose.
Note: The affected servos will go into FREE state when the Snapshot icon is 
clicked. Be careful to avoid the robot falling or other abrupt motion.

Click on the Snapshot icon a second time. The current servo positions will be 
captured and the servos will return to SERVO mode. The POS settings are 
automatically updated with the new position data.

· New LINKs are appended to the pull-down LINK menu and can be reused at any 
time to quickly modify the positions of servo combinations. This technique can be 
very effective for frequently modified servo combinations, like legs and arms.

· Using the Teach mode, a servo may sometimes be manually moved beyond its 
defined movement range, however, H2H3 will limit the captured position data to 
within the allowable range.
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Motion Calls and Jumps

The RCB-3 supports Calls and Jumps from the current motion to other motions. This is 
accomplished using SET objects created within the motion.

1 Write in a motion to a motion number you like.
In this explanation, we will let this motion be the destination of the jump.

The Jump function performs a unidirectional jump from the current motion being played to 
another motion. It does not support a return from the new motion (see Call below).

●Jump to a Destination Motion

Creating a Motion Jump

2 Place SET object (SET1) on data sheet.

This is a simple example to illustrate the Jump creation process. In actual use, the SET object would be 
inserted into a motion with several objects.
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3 Double-click on the SET object to display the SET Object Editing window. Select “Jump” and 
use the pull-down menu to select the destination motion.
Notes: The destination motion must already have been written to the RCB-3 memory. Make 
sure to read the current RCB-3 Data Table prior to creating Jumps.

4 Close the SET Object Editing window to apply the changes. Place a Start Flag on the SET 
object.
Write the new motion to the RCB-3 (M8 in this example).
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End

5 Play the Motion

Play the new motion with the SET Object Jump. Assuming the steps above were done 
correctly, the new motion should jump to playing the destination motion. The motion flow is 
shown in the diagram below.

M8  untitled M1 Walk(FWD)

Start 

End 

Jump



46

Intermediate

The Call function transfers execution (play) from the current motion to a destination motion. 
When used in combination with a Return, the destination motion can automatically return play 
to the original motion.
To create a motion Call, insert a SET Object and edit its settings to “Call” and select the 
desired destination motion.

●Call a Motion

●Return from a Call
The Return from a Call function transfers execution (play) back to the original calling motion 
and continues play with the object immediately following the original Call object.

Note: If there is no Return from Call Set object in the destination motion, then the motion 
execution will stop. Also, if the motion is played directly without being called, then the Return 
Set object will be ignored.

M8  Untitled M1  Walk(FWD)

Start

End

Call up

Return from 
call up
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Insert Function
During motion creation the need to add additional robot poses comes up frequently. H2H3 
makes this easy using the Insert function. The function supports automatic creation of a number 
of new POS objects between any two existing sequential POS objects.

1

2

Create two POS objects (POS1, POS2) on the Datasheet. Edit their settings so that they 
represent two different robot poses.

Use the Flow Wiring tool to connect the two POS 
objects.

3 Select POS1 and POS2 and right-click with the mouse. Select the “Insert” function from the 
pop-up menu. .

Example:
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5 The new POS Objects will be automatically inserted and connected. (POS3 in this example)

4 The “Insert” input window will be displayed. Enter the number of new POS Objects to be 
created. For this example the default value of 1 was used.

Note: The servo values and speeds for the new POS Objects are linearly interpolated. For 
example, if “n” new objects are inserted then the incremental change in values between 
objects is calculated using “n+1” as the divisor and digits beyond the decimal point are 
ignored.

The Insert function is useful to subdivide a very large motion between 
two poses into smaller segments. Or, to fit a motion between two 
poses to a curve to make it smoother or more lifelike.

Points
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LINK Function: Position Editing

The LINK Function 

The LINK function is an extremely powerful editing function used with the POS object. Mentioned briefly in 
the previous manual section on the Teach Mode, the LINK makes POS object editing much more efficient by 
supporting the creation of user defined servo channel combinations (LINKs), and applying the same setting to 
all servos in the LINK at simultaneously.

CH1~CH24 - Pull-down menus for each channel determine the function to be applied to the channel by the 
LINK. Note: For some functions a numeric value also needs to be entered.

Name - Used to assign a name to each LINK. New LINK names are appended to the LINK list when they are 
saved to provide quick access during POS editing.

Open - Opens previously saved LINK definition files (see below). 

Note: The PC file extension for LINK definition files is identical to Motion files (.RCB), but the content is different. 
Please organize saved LINK definition files using a separate disk folder. If a Motion file is accidentally opened 
when trying to open a LINK file, nothing will happen.

Save - LINK definitions can be saved to a PC file for later use.

Delete - Use the pull-down menu to select the LINK to be deleted, then click “Delete”

OK - Applies any edits or changes and closes the window.

Cancel -  Cancels any edits made and closes the window.
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Points: For LINK functions using incremental values (not 
including TCH), using the Increment LINK -/+ control will 
increase or decrease the servo channel value by the 
incremental amount.

PRM (?): Parameter 
Sets the servo channel value to the number inserted within the parentheses. For example, the KHR-2HV uses 
KRS-788HV servos with a 180 degree rotational range. A 90 degree rotation corresponds to a parameter of 
261. Therefore, the PRM numeric range is -261 ... 261 (whole integers only).

MOV(?): Move 
The current servo channel value is incremented by the number inserted within the parentheses.  The MOV 
numeric range is -261... 261 (whole integers only).

TTL (?): 
Sets the channel output to High, or Low, logic levels based on the value within the parentheses. This is primarily 
used when interfacing to devices other than servo motors.

Usable Values:   0 -> (L/0V) , 1 -> (H/5V)

SET (?): 
Applies a previously defined set (SET1, SET2, SET3) of ICS parameters to the servo channel based on the 
value within the parentheses. This can be used in PWM mode, but not Serial mode, and only applies to KONDO 
Red version servos.

Usable numerical values: 
1 -> SET1
2 ->SET2 
3 -> SET3

FREE: 
Puts the servo into FREE mode (only applies to KONDO Red version servos.)

SPD (?): Speed 
Sets the POS speed to the value within the parentheses. If the value is preceded by an explicit plus or minus 
sign, then the value is treated as incremental and the servo channel value is incremented by that value. Note: 
This is functional for Serial servos only and can not be used in PWM mode.

Usable numerical values: 1-127 

STR (?): Stretch 
Used in Serial servo mode only (not PWM), the servo stretch parameter is set to the value within the 
parentheses. If the value is preceded by an explicit plus or minus sign, then the value is treated as incremental 
and the servo stretch parameter is incremented by that value. 

Usable Numeric Values:  1-127.

TCH: Teach 
Sets the servo channel for use by the Teach function. (Applies only to KONDO Red version servos)

LINK Settings Explanation
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LINK Function Examples 

PRM: Parameter 
Since the PRM function automatically sets the assigned servo positions it can be used to simultaneous set a 
combination of servos to frequently used positions. Note: The corresponding channels must be set to SERVO 
mode, otherwise the operation is ignored.

Using the LINK PRM function to create frequently used postures-Points 

Note: The example below uses the KHR-2HV configuration and values. Refer 
to the POS Editing Window example (page 31) for servo positioning.

The LINK PRM settings shown above will be automatically applied to the active POS object when OK is clicked.
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MOV: Move 
Points: Using the LINK MOV function to incrementally step servo settings-
Used in conjunction with the Increment LINK -/+ control, the MOV function automatically increments (or 
decrements) the servo values as defined in the LINK. This can be used to efficiently make adjustments to 
positions that involve multiple servos.

In the POS window, select the LINK, then use the LINK -/+ 
control arrows to increment or decrement the servo values.

The example, shown below, simultaneously increments the hip, 
knee, and ankle servo settings for a KHR-2HV. This causes 
the robot to squat smoothly while maintaining the orientation of 
other servos. 
The “Link Editing” window defines the incremental MOV function 
values for each servo.

LINK Function Examples
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LINK Function Examples

Convert Functions

Convert Window Explanation

The Convert functions enable the editing or modification of multiple servo values simultaneously. For example, 
servo values can be calculated, reversed, or swapped.

CH1~CH24  - Pull-down menus determine the convert function to be applied to each channel.

Name – Assigns a name to each set of Convert operations. The function can then be saved and easily applied 
again later using the pull-down menu.
  
Open - Previously saved Convert functions can be opened from the PC disk for use. Note: The file extension 
used for Convert functions is the same as Motion Data (*.RCB), however the internal data is different. The 
creation of a separate file folder for Convert file storage is recommended. Also, if a non-Convert file is opened 
then nothing will happen.

Save - Used to save the current Convert function to the PC disk for later use. Note: The Convert function name 
must be set prior to saving the Convert Function to the PC disk.

Delete - Deletes the current Convert Function.

OK - Closes the Convert window and makes any changes effective.

Cancel - Closes the Convert window without making any changes effective.
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Convert Function Definitions

CopyTo(?): Copy 
Copies the current CH value to the CH indicated by the number in parentheses.
Usable range: 1-24 (integer only)

ReadTo (?): Read 
Effectively the reverse of the CopyTo function, the ReadTo function sets the current CH value to the value of the 
CH indicated by the number in parentheses.
Usable range: 1-24 (integer only)

Change (?): Change 
Swaps the values of the current CH and the CH indicated by the number in parentheses.
Usable range: 1-24 (integer only)

Reverse: 
Reverses the CH value (changes the value sign: positive/negative)

PRM (?): Parameter 
Sets the CH value to the number in parentheses. Note: Care should be taken to remain within the effective 
servo range. For example, the KRS-788HV servos used in the KHR-2HV move approximately 90 degrees with 
a value of 261. Therefore, the usable range for the KRS-788HV is -261 to +261.
 Usable range: Effective servo value range

ADD(?): Add 
Increments the current CH value by the number in parentheses.
Usable range: Effective servo value range

MUL (?): Multiply 
Multiplies the current CH value by the number in parentheses. Note: Decimal values can be used within the 
parentheses, and the resulting value is rounded to the nearest whole number.
Usable range: -1000.00 to +1000.00

SPD(?): Speed 
Modifies the POS Object SPEED based on the number in parentheses. Note: Applying the SPD function to any 
CH changes the SPEED value for the entire POS Object. Decimal values can be used within the parentheses, 
and the resulting value is rounded to the nearest whole number.
SPD Function Formats-
 n -> SPEED = n (sets the SPEED to n)
 +n -> SPEED = SPEED + n (increments the current SPEED by n)
 -n -> SPEED = SPEED –n (decrements the current SPEED by n)
 *n -> SPEED = SPEED * n (multiplies the current SPEED by n)
 /n -> SPEED = SPEED/n (divides the current SPEED by n)
Usable range: -1000.00 to +1000.00
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Mirroring Poses

Using the Change and Reverse functions, key portions of the robots pose can be easily mirrored.

This example uses the “1HV011_bowing.RCB” motion to illustrate the 
mirroring process.1

Select the POS object(s) to be modified, then right-click and 
select the “Convert” option. 

2

The Change functions shown in the Convert window below 
(Mirror_01) will swap the CH values with the CH values indicated in 
the parentheses.

3

Convert Function Example

Note: This example uses the KHR-2HV CH servo assignments.
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Check the “bowing_01” POS object pose. With the original settings the robots right 
arm was extended forward. After applying the two Convert functions described above 
the robot pose has been mirrored so that its left arm is extended forward.

The Convert function can be very useful to modify poses and 
motions when:

·Mirroring poses and motion sequences 
·Adding additional degrees of freedom (servos) to the robot
·Replacing servos with different models that have different 

parameters
·verting existing motions from the RCB-1 to the RCB-3

Points

Following the same process, the Reverse functions in the Convert window below 
(Mirror_02) will reverse the assigned CH values.4

Before conversion After conversion
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Motion creation using dividing function

Conditional Branching 
A Conditional Branch changes the motion execution (play) flow. A specific condition (preset value, loop 
counter, sensor input, etc.) is tested and the motion flow is modified accordingly.

SET: A SET Object is used to pre-set a numeric value that will 
be tested later in the motion.1

A typical Conditional Branch within a motion will follow this pattern:

CMP: A CMP Object tests  to see if the Branch conditions 
have been met, and modifies the motion flow.2
Motion Flow – Branch Path: If the Branch conditions are met, 
then the motion flow follows the dotted path3
Motion Flow – Non-Branch Path: If the Branch conditions are 
not met, then the motion flow follows the solid path.4

SET
“ Set Loop Counter” – The slider bar or numeric input is used to pre-set how many times the 
motion will play the objects included in the loop. The Loop Counter is decremented by 1 each 
time it is tested by a CMP Object. Branching conditions are True when the Loop Counter 
value is 0.
Usable Range: 1-255 (integer)

“ Set Comparison Register” – Stores the entered value in the Comparison Register to be 
tested by a subsequent CMP Object. 
Usable Range: -1023 to +16383 

CMP Object Settings
“ Loop Counter <> 0” – Motion flow will follow the Branch path unless the Loop Counter is 0. 
The Loop Counter value is decremented by 1 each time it is tested by a CMP Object.
 “AD1 Change > Comparison Register”
“AD2 Change > Comparison Register”
“AD3 Change > Comparison Register”
Motion flow will follow the Branch path as long as the corresponding analog sensor input 
value change is greater than the Comparison Register value (pre-set with a SET Object).
 
Note: Current AD1-AD3 values can be displayed using the Analog icon on the main menu.
 

Confirmation  As previously described, use the Analog window AUTO button to set the sensors 
base reference value before determining the sensor change values.
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“ Remote Code = Comparison Register” 
Motion flow will follow the Branch path if the remote control code equals the Comparison Register 
value (pre-set with a SET Object).

“ Remote Code AND Comparison Register <>0”
Motion flow will follow the Branch path if both the received remote control button value and the 
Comparison Register value are not equal to 0.

“ PA1 Change > Comparison Register”
“ PA2 Change > Comparison Register”
“ PA3 Change > Comparison Register”
“ PA4 Change > Comparison Register”

Motion flow will follow the Branch path as long as the analog value received from the remote control 
is greater than the Comparison Register value (pre-set with a SET Object).
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Conditional Branch Example

Repeating a motion sequence using the Loop Counter 
The Loop Counter can be used in conjunction with SET and CMP objects to 
repeat a motion sequence a pre-set number of times. The example below 
illustrates this technique using ‘push-ups’.

The KHR-2HV push-up sample motion (2HV018_push-ups.RCB) is shown in the diagram below..1

Double click on [number of times to loop (5)] and open window.
([number of times to loop (5)] is a name made for SET)
Confirm that 5 is set on loop counter.

2

Double click on [divide 01] and open window.
([divide 01]is a name made for CMP).
Confirm that [jump if loop counter is not 0] is 
selected. 

3
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The Loop Counter value is decremented by 1 and then tested by the CMP object.
Points

When the motion is played, the Loop Counter is pre-set by the “frequency: 5 times” SET object, and 
tested by the “CMP01” CMP object. 
If the Loop Counter value is not 0, then, the motion flow branches to replay the “push-up_A” through 
“push-up_D” POS objects.

4
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Conditional Branch Example

Accelerometer Installation  

Motion sequence branching can be controlled by testing the amount of change in a sensor input. 
In the example below, an accelerometer is used to detect if the robot has fallen down, and which 
direction it should rise.

Necessary Items:

RAS-2: Two-axis Acceleration Sensor Connection cable 100mm (sold separately)

Using the connection cable, connect the 
accelerometer X-OUT terminal to the RCB-3 
AD3 analog port.

Note: Refer to the appropriate user manual for information on sensor mounting 
locations and orientation.

RAS-1: Two-axis Acceleration Sensor

or

Note: RAS-1 production stopped 
December, 2006

Y

X

SIGNAL
 ＋（５V)

GND

X-OUT

Y-OUT

AD
 

1
AD 2

AD 3

 

input
input

inputRAS-1 – The X-OUT 
terminal is the upper 
terminal (see drawing)

Y

X

SIGNAL
 ＋（５V)
GND

X-OUT

Y-OUT

AD 1
AD 2

AD 3

input 
input 

input 
RAS-2 – The X-OUT 
terminal is the lower 
terminal (see drawing)

RAS-1 RAS-2

Automatic Determination of Rising Direction Using an Accelerometer
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RCB-3 Set-up

With the accelerometer installed (see above), turn on the RCB-3 
and run H2H3.1
Click the Analog icon on the Main Menu to display the Analog Setting window.
Select the “Input 3” (AD3) tab.
The value measured by the accelerometer is displayed (see screenshot below).
Adjust the slider bar to set the base reference value (Ref) to 0

Confirmation
       If the RCB-3 is not correctly connected the Analog Setting window will not open.

372 372
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Using the figures below as examples, place the robot in prone (face down) and supine (face up) positions and 
record the measured accelerometer values.
Close the window after recording the measured values.

2

The following example uses KHR-1HV sample motions, but the same basic technique applies to other robots.
Using a blank new Datasheet, load the “1HV009_to stand up (look up).RCB” and “1HV010_to stand up (on his 
belly).RCB” sample motions, and arrange them according to the screenshot below.

3

RAS-1

RAS-2

RAS-1

RAS-2
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Create a SET (SET1) object at the top of the Datasheet. Double-click on the SET object to display the Set 
Object Editing window.Subtract 10 from the value measured when the robot was in a supine (face up) position. 
Enter the calculated value in the “Set Comparison Register” box.
Note: Typical values are approximately 400 (RAS-1) or 390 (RAS-2).

4

Create a second SET (SET2) object at the top of the Datasheet. Double-click on the SET object to display the 
Set Object Editing window.Add 10 to the value measured when the robot was in a prone (face down) position. 
Enter the calculated value in the “Set Comparison Register” box.
Note: Typical values are approximately 335 (RAS-1) or 130 (RAS-2).

5
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Create a set of new CMP objects (CMP1 and CMP2) at the top of the Datasheet. These will be 
used to control the motion branching.
Double-click on each of the two new CMP objects, and select “AD3 Change > Comparison 
Register”.

6

Connect the Datasheet objects as shown in 
the example to the right. Place the Start Flag 
on the SET1 object.

7

When played, the motion first checks to see if 
the robot is laying in a supine position (SET1, 
CMP1). If it is, then the corresponding motion 
is played. If it is not, then the motion checks 
to see if the robot is laying in a prone position 
(SET2, CMP2), and plays the corresponding 
motion. Otherwise, it branches to the last 
HomePos object.

8

The Comparison Register values used above are examples and can be changed to any 
appropriate values depending on the actual application.

Points
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Conditional Branch Example (2)

Remote Control: Generating Continuous Motion
Conditional branching can be used to have motions play continuously as long as a button on the remote 
control is pressed.
The following example illustrates the use of conditional branching to have the robot walk forward 
continuously while the corresponding button is pressed.

Make sure that the RCB-3 and remote control are set-up in 
accordance with the procedure earlier in this manual..1

Using a new blank Datasheet, load the “1HV001_
walk(forward).RCB” sample motion. Double-click on a blank 
area of the Datasheet to display the Data Dialog window.
Map the motion to a remote control button using the 
procedure covered in the Remote Control section of this 
manual.
In this example, “1” is used as the Control Input value, but 
any remote control key, or key combination can be used.

2

Create a new SET object (SET1) on the Datasheet. Double-click on the object to display the SET 
Object Editing window. Select “Set Comparison Register” and enter the Control Input value (“1” in 
this example).

3
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Create a new CMP object (CMP1). Double-click on 
the object to open the CMP Editing window. Select 
“Remote Code = Comparison Register” 

4

Edit the motion flow and branch wiring in accordance with the diagram. This includes adding the 
CMP1 and its connections to the flow, as well as moving the Start Flag to the SET1 object.

5

Write the new motion to the RCB-3, and test its operation.
Pressing the assigned key on the remote control will play the motion. The SET1 object stores the 
pre-set key code in the Comparison Register. The CMP1 object tests to see if the key is still pressed, 
and branches to replay the walk sequence. If the key is released, then the CMP1 follows the path to 
bring the robot to the HomePos.

6



68

A d v a n c e d
Using the Start Switch  to Play Scenarios 

Setup

The RCB-3 Start Switch (Switch1) can be used to play scenarios without the use of a connected PC or 
remote control. This is often used for demonstrations or autonomous operation.

Load the current Data Table from the RCB-3 and select a scenario to be played when the Start Switch is 
pressed.

1

Switch1

AD 1
AD 2

AD 3

1
2

4
5

6
7

8

9
10

1112
13

1415
16

Output 24
23

22
21

20
19

18
17

Power supply terminal

Power supply setup

3

       External switch 
connection terminal

LED2 (green)

LED1(red)

Low speed serial terminal

High-speed serial terminal

Output
Output

Output
Output

Output
Output

Output

Output
Output Output

Output
Output

Output
Output

Output

Output
Output

Output
Output

Output
Output

Output
Output

input
input

input

Click the Option icon on the main menu to display the Option 
window. Use the “Start Switch Motion” pull-down menu to 
select the desired scenario.
Confirmation: The Option window will not be displayed unless 
the RCB-3 is turned on and properly connected to the PC.

2

Confirmation 
The Option window will not be displayed unless the 
RCB-3 is turned on and properly connected to the PC.

Close the Option window to apply the changes.3
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Confirm Operation

Adding an External Switch 

Press and hold the Start Switch until the Green LED (LED2) turns off (approximately 3 seconds), 
then release the switch to start the scenario playing.

For ease of access and operation, an external switch can be added in parallel with the Start Switch. 
Note: Use a 2.54mm pitch board cable connector.

Since both switches are connected in parallel, pressing either switch will trigger playing of 
the assigned scenario. It is not possible to disable one switch while enabling the other. 

Point 

If the Start Switch is pressed while the scenario is playing, it will stop playing at that point.

Pressing and holding the Start Switch again will cause the scenario to replay from the 
beginning.

Points
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Playing a Low Power Scenario

Set-up

The RCB-3 monitors the power supply voltage level and can generate an interrupt when the voltage 
reaches a pre-set limit value. This can be used to automatically play a scenario.

Load the current Data Table from the RCB-3 and select a scenario to be played when the low power limit is 
reached.

1

Click the Option icon on the main menu to display the 
Option window. Use the “Low Power motion” pull-down 
menu to select the desired scenario.

2

The Option window will not be displayed unless the 

RCB-3 is turned on and properly connected to the PC.

Enter the desired low voltage limit value. 
Range: 5.5V to 15.0V3

Close the Option window to apply 
the changes.4

The current power supply voltage can be 
checked using the Analog window.

Points

Confirmation 
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Confirm Operation

When the robot power supply voltage drops to the pre-set limit value the assigned scenario will be played.
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Using Sensor Levels to Play a Scenario

Setup

Change in sensor input can be set as a limit value to generate an interrupt and trigger playing an assigned 
scenario.

Load the current Data Table from the RCB-3 and select a scenario to be played when the sensor limit value 
is exceeded.1

The Analog window will not be displayed unless the RCB-3 is turned on and properly 
connected to the PC.

Click the Analog icon on the main menu to display the Analog window. 
Select the tab for the appropriate sensor input. Use the “Playing the motion with interrupt of a sensor” pull-
down menu to select the desired scenario.

2

Confirmation 
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Enter the desired sensor change limit value.3

Note: For each analog sensor input, up to two values, and corresponding 

scenarios to be played, can be set-up.

Points 

Close the Analog window to 
apply the changes4

Confirm motion

The sensor interrupt will occur when the sensor input value change exceeds the pre-set trigger level and 
the selected motion will automatically play.



74

A d v a n c e d
Inhibiting Sensor Interrupts

During some motions you may want to inhibit sensor interrupts. This is 
accomplished using a SET object.

Click the appropriate “Sensor Control Enabled” check box for the sensor channel to be inhibited. 2
3  Each sensor channel has two check boxes corresponding to the two assigned motion scenarios.3

Place a SET object on the Datasheet and double click1

The SET object settings remain in effect until the RCB-3 is restarted, or a 
subsequent SET object changes them..

Points 
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1.Acceleration of motion playing speed

Setting steps
Delete wiring that connects [C], [F](POS object) and 
[divide](CMP object).1

Copy [C] and [F] and paste them (rename both as [C’] 
and [F’]).2

The biggest change from the version before the update (before Ver. 1.02) is this function.
Before, with RCB-3  Ver. 1.02, with inter-object speed conversion - 1 to 2 and time unit conversion – 15ms - 
30ms(when output period is 15ms) had been consumed when passing through SET object and CMP object while 
playing motion scenario.  However, Ver. 1.03 has accelerated to a minimum of 2ms, and the time lag of motion 
dividing using CMP object has become particularly minute. (the passing time of SET, CMP differs depending on each 
objects setting).
However, due to this, Ver. 1.03 is unable to completely reproduce motions such as the walking motion that were 
created before Ver. 1.02.
We will explain how to deal with this by using the walking motion of KHR-1HV as an example.

Explanation

●Added functions●
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Open POS window of [C] and 
[F] and make the numerical 
value of SPEED 2.

3

Wire of motion.
[C]→[C’]→[CMP] (dividing)
[F]→[F’]→[CMP]  (dividing)

4

By placing [C’] and [F’] in this way, you can create a state close to the time lag when dividing that was seen in 
Ver1.02 and before.
However, this method does not completely guarantee an accurate reproduction.
In order to bring the performance of Ver. 1.03 RCB-3 to full play, we recommend  you to modify the motion 
itself.

5
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2.Addition of jump to motion scenario and calling function

We have added the function of jumping to a motion scenario while playing another motion scenario and the function 
to call up.
For details, please refer back to p. 43 of this manual.

Explanation

3.Addition of MIX object

We have separated the mixing settings from SET object and made it independent as MIX object.

For details, please refer back to p. 36 of this manual. 

Explanation

4. Addition of trim position button

We have added the concept of trim position and the button to return to trim position.

For details, please refer back to p. 20 of this manual.

Explanation

5. Addition of dividing function

We have added the function that enables the insertion of poses divided into the number of choice between two POS 
objects (poses) connected by wiring.

For details, please refer back to p. 47 of this manual.

Explanation

6. Addition of parameter settings to converting function 

We have added settings PRM(?) that substitutes position parameter to converting function.

For details, please refer back to p. 53 of this manual. 

Explanation

7. Addition of functions to speed settings of converting function 

It has been made possible to directly substitute the value of speed by speed settings SPD of converting function.

For details, please refer back to p. 54 of this manual.

Explanation

For motions created before Ver. 1.02 and with its mixing set up by SET object, please delete that SET object 
and replace it with MIX object in order to use. 
Difficulties may occur if you use a SET object that you have made mixing settings on in Ver. 1.03 and later.  

Caution:
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8.Making objects and different kinds of settings into files

It has been made possible to save and read in individual objects of POS, SET, CMP, MIX from the right click 
menu on the main screen. 
For details, please refer back to p. 17 of this manual.

Explanation
Making objects into files 

It has been made possible to save and read in converting settings.
For details, please refer back to p. 53 of this manual.

Making converting settings into files 

It has been made possible to save and read in LINK settings.
For details, please refer back p. 49 of this manual.  

Making LINK Settings into files

9.Modification of data table 

When writing in more than 30 datas spread across more than one motion number, the motion name is now displayed 
on all motion numbers.
Also, when deleting that motion, all motions are now deleted if you specify the first motion number.
For details, please refer back to p. 28 of this manual.

Explanation

10.Modification of environment settings

We have made the default value of grid interval X5 Y5.
Explanation 
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●Deleted functions●

1.Deletion of multi-task function 

Because this function could not be used along with the acceleration of motion play speed, we have deleted the multi-
task function.

2.Deletion of compulsory cut-in when doing sensor input

Because this function could not be used along with acceleration of motion playing speed, we have deleted the 
function of compulsory cut-in when motion playing.
For details, please refer back to p. 70 and p.72 of this manual. 

1.We have solved the problem of motion play speed slowing down when

 using wireless radio.

We have solved the problem of motion play speed slowing down when using wireless radio under certain conditions that 
had been happening in Ver. 1.02 and before.

●Other●

2.We have solved the problem of the content being displayed abnormally when

 using converting function to SET object.

3.We have solved the problem of file size when saving.  

We have solved the problem of the file size of motion data files enlarging every time saving under certain conditions 
that had been occurring with Ver. 1.02 and before.
However, the meaning of this is that files with those problems will no longer be created in Ver. 1.03 and later. If you 
create such a file in Ver. 1.02 or before and keep on using it with Ver. 1.03, the problem will not be taken care of.

Even more advanced uses will be explained in our company website. 
 Also, for updates on this manual and software after purchase, 

please see our support page. 
 http://www.kondo-robot.com

Explanation

Explanation

Explanation

Explanation



RCB-3


	CoverPage
	Befor Reading
	Caoutions
	Table of Contents
	HardWare
	Software
	Install
	Main Menu
	Command menu

	Introduction
	Setting home position
	Create start up motion

	Intermediate
	Wireless radio setting

	Advances
	Play motion scenario by start switch

	Update
	Acceleration of motion playing speed
	Addition of jump to motion scenario and calling function
	Making objects and different kinds of settings into files
	Making objects and different kinds of settings into files

	Other

